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Synopsis:
The  QuickView  utility  was  designed  for  quick  and  convenient

examination  of  different  files'  contents  in  MS Windows  environment.
QuickView allows to view Text and Graphics files of various formats.
You can make some standard operations with files (Copy, Move, Delete,
e.t.c.)  and their contents (Search for text,  Stretch/Shrink bitmap, e.t.c.)
with help of QuickView program. The QuickView window divided on
seven parts. You can see them on  Figure 1-1.

 Fig 1-1.

 1  -   The Main Window 
 2  -   The Main Window
 3  -   The List of Files
 4  -   The List of Directories
 5  -   The Status Bar
 6 -    The ToolBar
 7 -    The Ruler
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LICENSE
Quick View is not and has never been public domain software nor is it

free software
Non registered users are granted a limited lecense to use QuickView

on a 21-day trial basis for the purpose of determining wheter QuickView
is suitable for their needs. The use of QuickView, except for the initial 21
day trial requires registration. The use of unlicensed copies of QuickView
by  any  person,  business,  corporation,  goverment  agency  or  any  other
entity is strictly prohibited.

A single  user  license perimits  a  user  to  use  QuickView only on a
single  computer.  Licensed  users  may  use  the  program  on  different
computers, byt may not use the program on more than one computer at
the same time.

No one may modify or patch the QuickView executable files in any
way, included but not limited to decompiling, disassembling, or otherwise
reverse engineering the program.

A limited license is granted to copy and distribute QuickView only for
the  trial  use  of  others,  subject  to  the  above  limitations,  and  also  the
following :

1) QuickView must be copied in unmodified form complete with the
provieded license and registration information.

2)  The  full  machine-readable  QuickView  documentation  must  be
included with each copy.

3) QuickView may not be distributed in conjunction with any other
product with out a specific license to do so from SKDS Usa.



DISCLAIMER
Deming Software makes no warranties, either expressed or implied,

including, but not limited to fitness for a paticular purpose and implied
warranties of merchantabiliy, for this product.  Deming Software will not
be responsible for any loss or damages resulting from the use or misuse of
this product, even if we have been made aware of the possibility of such

loss or damages.

In short, USE AT YOUR OWN RISK.  We will not be responsible for
ANYTHING, EVER, UNDER ANY CIRCUMSTANCES.



Purpose of each Part:

1. The Main Menu
Main Menu provides access to a number of commands in QuickView.

It  consists  as  File,  Transfer,  Bitmap,  Text,  View,  Options  and  Help
menus. Each of tem will be descirbed below. 

2. The Main Window
In this window you can see current file's content. This is a most significant part
of application. There are two scroll bars on edges of Main window. You can
use them by means of scrolling content of current file. If you click left mouse
button over the Main Window, it becomes active and you can use the cursor
keys for scrolling text in the Window.

To mark part of text in the Main Window ( in order. to transfer it to
other file ), just click right mouse button at the beginning of text fragment
and than click at the end of fragment. You can perform  any operation
with QuickView and other applications between these clicks.

3.  The List of  Files 
In this window you see the list of files of current directory. To view

file's content click on file's name in this list and you will see content of
the file in the Main window. 

 4.  The List of Directories
In this window you can see the list of available drives and directories.

To  change  current  directory  or  drive  in  this  list  just  double-click  on
corresponding item. 

5.  The Status Bar
Status bar reflects the status of Quick View. The status bar contains

six sections: 1 - full name of file you examine in Main Window, 2 - the
size of current file, 3 - attributes of current file, 4 - the name of current
viewer, 5 - current vertical position in the file, 6 - horizontal position in
the file.

6. The ToolBar 
Tool bar contains controls  bars to adjust  viewing or perform some

operations with the current file.  The first control bar contains a list  of
several viewers (methods of viewing). You may select any viewer from
the list for change the viewing method for the current  file. For example:
you view bitmap as a picture, if you select 'Hex' from the list of viewers
you can see the Hex dump of the bitmap. 

Next two controls bars contain current font parameters. You can select
any face from the list of fonts and any size from the list of  font sizes.
This  control  bars  are  used  only  for  text  based  viewers  (for  Example:
ANSI Text or Hex Dump). 



First three controls are the buttons that perform some operations on the
Bitmaps.

 First button performs Stretch/Shrink operation. It toggle between small and large 
bitmap pictures in the Main Window. If you view an Icon , and press this button the 
icon will be enlarged  several times.

 Second button performs Tile operation, if you wish to choose the wall paper for 
windows and make the preview of bitmaps for it, you can press the tile button and see
how this bitmap looks for tiled wallpaper.

 Third button performs Invert operation, when you press this button all colours on the 
bitmap become negative. This button doesn't work with compressed bitmaps in this 
version of QuickView.

Next two buttons are the text command buttons. 

 The first button intended for search operations. (Look the 'commands' section). 

 The second button performs the Line Wrap command.It allow you to view the texts 
with line larger than Qview window, the right parts of lines will be moved to the next
lines. ( This command not change the contents of the file).

Next two button is an open and print commands.

 The first button calls the application which can work with currently viedwed file and 
the application opens this file. ( This application must be installed in your system, and
must be compatible with Windows 3.1 shell convention). If there isn't application for 
current file installed in your system, nothing happens

 The second button is the same as the first, but the application will print the currently 
viewed file.

7. The Ruler
The Ruler is used to define horizontal dimensions of displayed file in 

text format.

Keyboard Operations:

Changing active window:
    If  you  want  to  change  active  window  using  keyboard,  press

<Ctrl+Tab> key .You will see the caret in active window ( if the list of
directories or the list of files is active), or the hair border around the Main
Window ( if Main Window are active).

Changing current drive or directory :
To change current drive or directory select it in the list and just press

<Enter>.



Commands: 
The File Menu has several commands: New Mask,Ren/Move,Copy,

Delete, About and Quit. 
New Mask. This command allows you to choose what files you

want to see in the files list. When you select this command you will see
the dialogue box as on figure 1-2.

    
Fig 1-2

In the dialogue box you can write the DOS wildcard character for
files that you want see in the list of files. If you click on 'Show Hidden
Files" check box you will be able to see the hidden and system files in the
"List of files". Normally those files are not visible for you. (Usually this
command  is  used  for  viewing  of  the  certain  type  of  files  in  large
directory.)

Copy  This command allows you to copy selected source file in the
files list to the destination file. When you select this command you will
see the dialogue box as on figure 1-3

 
Fig 1-3

 In the top box you see the source path, in the bottom one you see
the destination path. Usually the source and destination path are the full
paths to currently selected file. You can change any of these paths and
press  "Copy".  (Wildcards  are  not  allowed  in  the  current  version  of
QuickView).

Ren/Move This command allows you to rename or move selected file.
When you select this command you will see the dialogue box as on figure
1-4

  
Fig 1-4

In the top box you see the source path, in the bottom box - the
destination path.  Usually the  source and destination  path are  the  full
paths to currently selected file.  You can change any of this paths and
press  "Rename".  Wildcards  are  not  allowed  in  the  current  version  of
QuickView.

Delete This  command  allows  you  to  delete  the  selected  file.
When you select this command you will see the dialogue box as on figure
1-5.



 
Fig 1-5

If you really want to delete selected file you press "Yes", and  say
good-bye to selected file. Otherwise you can press "No".  If you realy
sure enough and it's  not necessary for you to ask confirmation every time
you can suppress this Box, by using Options menu.  See Also Options.

Quit.When you want to finish working with QuickView  choose this
command.

The Transfer Menu
Copy Selection: You can select any part of the file by clicking right

mouse button at the beginning and the end of part of file you want to
mark.  Then you can choose Copy selection command for copying this
part of file to the clipboard. (This command work only with Text and Hex
viewers.)

Copy Page: This is more complex command. It depends on Viewer.
For bitmap viewer it copies all Bitmap to the clipboard. For  Text viewer
it copies the page to clipboard, page is 25 lines of text. For example you
stay on the 115 line in the text file, when you select this command, lines
from 100 to 125, will be copied to clipboard. For Hex viewer page is also
25 lines, but it always begins from top of the Window. For example if
you stay on 122 line of  Hex Dump and choose this command, lines 122-
147 will be copied to clipboard.

Clear Selection: This is very simple command. It only   hides any
marked block of a text in the file.

The Bitmap Menu
Stretch/Shrink. This command adjusts the Bitmap size to the size of

Main Window.
Tile. This command repeats the small bitmap and fill the whole Main

Window area. This is very useful for choosing wallpaper for Windows.
Invert.   This  command  inverts  all  colours  of  bitmap.  Useful  for

various purposes.

The Text Menu
Search:   This command allows you to find some text in a file (work

only with Text and Hex viewers). When you select this command you
will see the dialogue box as on fig 1-6.

 
Fig 1-6

In the top box you can type the Text for search, in the Bottom box you
can type Hex Pattern for search, when you type in one of the box, the
content of other box will change too accordingly. Also you can adjust
finding, by checking "whole word", and "match case" check boxes. To



begin searching press "Find" and the searching process will begin. When
the matched pattern will be found, it will be marked by colour (Default is
Yellow). 

Continue:  This command continues searching match text from the
last found position. 

Wrap Lines: This command very useful for viewing the Microsoft
Word files. It cut right part of long strings and shows it on the next line.

The View Menu 
All commands of this menu are used for enabling and disabling parts

of QuickView. If the checkmark presents aside the option this option is
enabled, otherwise it is disabled.

Options:    This  command  allows  you  to  adjust  Quick  View  for
convenience. When you choose this command you will see the dialogue
box as on figure 1-6

 
Fig 1-7

The  layout  section  controls  the  layout  of  Part  of  QuickView.   In
Standard  layout,  the list of Directories and List of  Files, have the  full
height of window and Directory list resides at the left side of  Window,
and  the  List  of  Files,  resides   at  right  side  of  list  of  directories.  In
Compact  layout : the list of directories and list of files  have the half size
of window and List of files resides on top and list of  directories resides
on bottom left corners of the window. But my  friend  Igor doesn't like
this layout and he proposes me to swap the List of Files and List of Dirs. (
If you send me your favourite layout I'll insert it in Next Version and send
it to you. ).

The  Default viewer is the viewer of files which can't be viewed of
their specific  Viewer

The measurement is the system of units that is used in the Ruler.
The  Delete  confirmations Check  Box  allows  you  to  suppress  the

confirmation on delete operation (  See the Delete  command). When it is
checked the QuickView always asks you when you execute the Delete
command.

Installation:
For install Quick view you must perform the following actions:
1.Put  QuickView  files  into  your  Windows  directory   (usually  C:\

Windows)
2.Add new program item to your program manager.

Appendix I: Customising QuickView: 
The QuickView always saves it's configuration in the Win.Ini

file in the QuickView section. Usually you have no need to edit this file,



but in the certain cases you can do it. Case One  if you use non standard
colour setting of the Windows you can adjust the Selection and Highlight
colour.  The  Selection  colour  controlled  by  the  keys  MarkBgCol  and
MarkFgCol. The Highlight colour is controlled by the keys   FIndBgCol
and  FindFgCol.   You can see  it  in  the   values  of  this  colors  in  the
Appendix I. Also you can order the ColorMix utility from RoyalSoftClub
for making your own colors. ( This package always contain the colorMix
utility ).

Table I:  The Values of Colour Keys

Red. 255
Green. 65280

Blue. 16711680
White. 16777215
Black. 0
Cyan. 16776960

Magenta. 16711935
Yellow. 65535
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	If you want to change active window using keyboard, press <Ctrl+Tab> key .You will see the caret in active window ( if the list of directories or the list of files is active), or the hair border around the Main Window ( if Main Window are active).
	Changing current drive or directory :

	To change current drive or directory select it in the list and just press <Enter>.
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	New Mask. This command allows you to choose what files you want to see in the files list. When you select this command you will see the dialogue box as on figure 1-2.
	In the dialogue box you can write the DOS wildcard character for files that you want see in the list of files. If you click on 'Show Hidden Files" check box you will be able to see the hidden and system files in the "List of files". Normally those files are not visible for you. (Usually this command is used for viewing of the certain type of files in large directory.)
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	In the top box you see the source path, in the bottom one you see the destination path. Usually the source and destination path are the full paths to currently selected file. You can change any of these paths and press "Copy". (Wildcards are not allowed in the current version of QuickView).
	Ren/Move This command allows you to rename or move selected file. When you select this command you will see the dialogue box as on figure 1-4
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	In the top box you see the source path, in the bottom box - the destination path. Usually the source and destination path are the full paths to currently selected file. You can change any of this paths and press "Rename". Wildcards are not allowed in the current version of QuickView.
	Delete This command allows you to delete the selected file. When you select this command you will see the dialogue box as on figure 1-5.
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	If you really want to delete selected file you press "Yes", and say good-bye to selected file. Otherwise you can press "No". If you realy sure enough and it's  not necessary for you to ask confirmation every time you can suppress this Box, by using Options menu.  See Also Options.
	Quit.When you want to finish working with QuickView choose this command.
	The Transfer Menu

	Copy Selection: You can select any part of the file by clicking right mouse button at the beginning and the end of part of file you want to mark. Then you can choose Copy selection command for copying this part of file to the clipboard. (This command work only with Text and Hex viewers.)
	Copy Page: This is more complex command. It depends on Viewer. For bitmap viewer it copies all Bitmap to the clipboard. For Text viewer it copies the page to clipboard, page is 25 lines of text. For example you stay on the 115 line in the text file, when you select this command, lines from 100 to 125, will be copied to clipboard. For Hex viewer page is also 25 lines, but it always begins from top of the Window. For example if you stay on 122 line of Hex Dump and choose this command, lines 122-147 will be copied to clipboard.
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	Tile. This command repeats the small bitmap and fill the whole Main Window area. This is very useful for choosing wallpaper for Windows.
	Invert. This command inverts all colours of bitmap. Useful for various purposes.
	The Text Menu

	Search: This command allows you to find some text in a file (work only with Text and Hex viewers). When you select this command you will see the dialogue box as on fig 1-6.
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	In the top box you can type the Text for search, in the Bottom box you can type Hex Pattern for search, when you type in one of the box, the content of other box will change too accordingly. Also you can adjust finding, by checking "whole word", and "match case" check boxes. To begin searching press "Find" and the searching process will begin. When the matched pattern will be found, it will be marked by colour (Default is Yellow).
	Continue: This command continues searching match text from the last found position.
	Wrap Lines: This command very useful for viewing the Microsoft Word files. It cut right part of long strings and shows it on the next line.
	The View Menu

	All commands of this menu are used for enabling and disabling parts of QuickView. If the checkmark presents aside the option this option is enabled, otherwise it is disabled.
	Options: This command allows you to adjust Quick View for convenience. When you choose this command you will see the dialogue box as on figure 1-6
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	The layout section controls the layout of Part of QuickView. In Standard layout, the list of Directories and List of Files, have the full height of window and Directory list resides at the left side of Window, and the List of Files, resides at right side of list of directories. In Compact layout : the list of directories and list of files have the half size of window and List of files resides on top and list of directories resides on bottom left corners of the window. But my friend Igor doesn't like this layout and he proposes me to swap the List of Files and List of Dirs. ( If you send me your favourite layout I'll insert it in Next Version and send it to you. ).
	The Default viewer is the viewer of files which can't be viewed of their specific  Viewer
	The measurement is the system of units that is used in the Ruler.
	The Delete confirmations Check Box allows you to suppress the confirmation on delete operation ( See the Delete command). When it is checked the QuickView always asks you when you execute the Delete command.
	Installation:
	For install Quick view you must perform the following actions:
	1.Put QuickView files into your Windows directory (usually C:Windows)
	2.Add new program item to your program manager.
	The QuickView always saves it's configuration in the Win.Ini file in the QuickView section. Usually you have no need to edit this file, but in the certain cases you can do it. Case One  if you use non standard colour setting of the Windows you can adjust the Selection and Highlight colour. The Selection colour controlled by the keys MarkBgCol and MarkFgCol. The Highlight colour is controlled by the keys   FIndBgCol  and FindFgCol.  You can see it in the  values of this colors in the Appendix I. Also you can order the ColorMix utility from RoyalSoftClub for making your own colors. ( This package always contain the colorMix utility ).
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